
 

 

GlobWetland Africa – Implementing 
Sustainable Earth Observation based Wetland 

Monitoring Capacity in Africa and Beyond 

  

 

 

 

 

 

 

 

 

 

 

GlobWetland Africa Toolbox 
Software User Manual 

 

Version 2.0 

Date: 24/04/2022 

 

 

 

 

 

 

   
 



 

GlobWetland Africa – Implementing Sustainable EO-
based Wetland Monitoring 

 

 

 

 

 

 

GLOBWETLAND AFRICA    PAGE | 2 

 

 
 
 
 
 

CHANGE RECORD  

 
Date Page(s) Description of Change Release 

23-05-2017 17 Template v1.00 

08-06-2017 30 Release of first draft for GW-A Toolbox, version 1.2 (beta) v1-1 

20-02-2018 32 Final version for first official toolbox release, version 1.3  v1-2 

- 32 Temporary working versions v1-3, v1-4 

20-03-2019 31 Version submitted with final toolbox release, version 1.5 v1-5 

24-04-2022 25 Version for toolbox update to QGIS 3.16 v2-0 

 

 

This document has been prepared under the DHI Business Management System  
certified by Bureau Veritas to comply with ISO 9001 (Quality Management) 

 

 



 

GlobWetland Africa – Implementing Sustainable EO-
based Wetland Monitoring 

 

 

 

 

 

 

GLOBWETLAND AFRICA    PAGE | 3 

 

 

Contents 

GlobWetland Africa Toolbox ...................................................................................................... 1 

1 Background ........................................................................................................................ 4 

1.1 Scope and objectives ................................................................................................... 4 

1.2 Development team ..................................................................................................... 4 

Getting Started ........................................................................................................................... 6 

2 GW-A Toolbox Installation and Configuration ................................................................... 7 

2.1 Introduction................................................................................................................. 7 

2.2 System Requirements ................................................................................................. 7 

2.3 Semi-automatic installation ........................................................................................ 7 

2.4 Uninstalling previous version of GW-A Toolbox ......................................................... 8 

2.5 Manual installation ................................................................................................... 10 

3 Basic usage instructions ................................................................................................... 12 

3.1 Troubleshooting ........................................................................................................ 14 

System Overview ..................................................................................................................... 15 

4 Toolbox Overview ............................................................................................................ 16 

4.1 Software Architecture ............................................................................................... 16 

4.2 Graphical User Interface ........................................................................................... 18 

4.3 Workflow, Scripts and Models .................................................................................. 18 

4.4 GW-A Toolbox workflows.......................................................................................... 20 

5 Updates ............................................................................................................................ 21 

6 Software references ......................................................................................................... 24 

Acknowledgement ................................................................................................................... 25 

 

  



 

GlobWetland Africa – Implementing Sustainable EO-
based Wetland Monitoring 

 

 

 

 

 

 

GLOBWETLAND AFRICA    PAGE | 4 

 

1 Background 
GlobWetland Africa is a large Earth Observation application project funded by the European 

Space Agency (ESA) in partnership with the African Team of the Ramsar convention on 

wetlands. The project is initiated to facilitate the exploitation of satellite observations for the 

conservation, wise-use and effective management of wetlands in Africa and to provide 

African stakeholders with the necessary Earth Observation (EO) methods and tools to better 

fulfil their commitments and obligations towards the Ramsar Convention on Wetlands. 

As a principal objective GlobWetland Africa is developing and demonstrating an open source 

and free-of-charge software toolbox for the end-to-end processing of a large portfolio of EO 

products and the subsequent derivation of spatial and temporal indicators on wetland status 

and trends. 

GlobWetland Africa (GW-A) is building on the legacy of its two GlobWetland precursors by 

further developing tools and products to effectively use the most up to date, open and free 

satellite data, primarily from the Sentinel missions, to address wetland conservation and 

management from a local, national and regional river basin perspective with a continental 

focus, being centered in Africa. The ultimate objective is to help African stakeholders (i.e. 

Ramsar Contracting Parties, Ramsar regional initiatives and African river basin authorities, 

etc.) and international/regional conservation agencies active in Africa to better assess the 

conditions of the wetlands under their areas of jurisdiction/study, and better monitor their 

trends over time. 

1.1 Scope and objectives 
The first part of this document provides the necessary information for installation and 

configuration of the GW-A Toolbox, while the second part of the document describes the 

system architecture and development including information on system customization and 

adaption/scalability. This document is accompanied by a Training Kit providing background 

presentations, a step-by-step tutorial and a tutorial data set designed to help the users 

become familiar with the features and capabilities of the GW-A Toolbox. 

1.2 Development team  
The GW-A Toolbox has been developed by a project consortium of Earth observation and 

ecosystem management experts including companies, research laboratories and universities 

that have hands‐on experiences in EO satellite technology applied to ecosystem mapping and 

monitoring, development of related EO and GIS processing tools as well as a proven track 

record of successful projects related to EO applications in the field of wetland inventorying, 

mapping and monitoring in Africa. The project consortium consists of the following partners: 
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DHI GRAS is specialised in the development and provision of earth observation, satellite 
image processing and Geographic Information Systems technologies. DHI has a strong 
background in remote sensing for hydrology, water quality, environmental assessment and 
land cover mapping. DHI works closely with universities, research institutions and commercial 

partners in order to develop innovative and cost effective applications that can be applied in a range of 
different projects. 

More information on DHI GRAS is available at the company’s website: http://www.dhi-gras.com 

GeoVille Information Systems is dedicated to the complete range of value added 
geographic information services in the land domain with special reference to 
environmental applications, including water related information solutions. The group 

provides products, services and consultancy in the field of digital information systems and 5pecializes in 
remote sensing and GIS applications. 

More information on GeoVille is available at the company’s website: http://www.geoville.com  

Previous versions included input and support from: 

The Faculty of Geo-Information Science and Earth Observation (ITC) of the University of 
Twente is a multidisciplinary scientific institute specialising in research and education in earth 
observation and geo-information science for the understanding, monitoring, predicting and 
sustainable use and management of natural resources. The Department’s mission is the 
sustainable management and meeting of societal needs from the green cover (biosphere) by 

applying and developing geo-information, earth observation and spatio-temporal analytical tools 

More information on ITC is available at the institutes website: 
https://www.itc.nl/  

Brockmann Consult GmbH (BC) has its expertise in turning environmental raw data into 
information products. Satellite observations, in-situ measurements and numerical model 
simulations are combined to provide status assessment and forecasts of physical or 
biogeochemical indicators. A wide range of applications is addressed and includes, for 

example, monitoring the eutrophication of national coastal waters, assessment of biodiversity in inland 
waters or mapping and monitoring of the UNESCO World Heritage Wadden Sea area. 

More information on BC is available at the company´s website: 
http://www.brockmann-consult.de/  

DTU ENVIRONMENT ‐ The Department of Environmental Engineering, (ENV) is a department 
at the Technical University of Denmark (DTU ENV) aiming at developing technical and 
sustainable solutions to minimize the impact of society on the environment. The research 
agenda is focused on monitoring and modelling of large‐scale water resources systems using 

ground based and space‐borne geophysical sensors. Specific research interests are the use of geophysical and 
remote sensing methods for hydrological monitoring and modelling, as well as integrated water resources 
management. 

More information on DTU ENV is available at the department’s website: http://www.env.dtu.dk/  

http://www.dhi-gras.com/
http://www.geoville.com/
https://www.itc.nl/
http://www.brockmann-consult.de/
http://www.env.dtu.dk/
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2 GW-A Toolbox Installation and Configuration 

2.1 Introduction 
The GW-A Toolbox is structured around a single GUI controlling a number of extension 

components that expand its core functionality. This allows the toolbox to cover the required 

capacity for integrated EO processing and GIS analysis to support wetland monitoring. QGIS 

has been chosen as the central integrating platform due to its clear and accessible GUI and 

strong development community. The integrated core components of the GW-A Toolbox are: 

GRASS GIS and SAGA GIS (large toolboxes of raster and vector analysis algorithms),  SNAP 

Toolbox (processing of optical and radar ESA data products including Sentinel satellite data), 

Orfeo Toolbox (high resolution image processing) and R and Python scripts (advanced spatial 

statistical analysis). All of these Open Source (OS) software components have been integrated 

into QGIS using the Processing toolbox and provide the users with a unique diversity of 

functionalities for image processing and spatial analysis, including customized plugins and 

workflows that have been developed in response to the user requirements for products and 

tools to support wetland status and trends assessments. 

2.2 System Requirements 
There are no minimum system requirements for using the GW-A Toolbox. The software itself 

is compatible with 64-bit computers equipped with Windows operating system, from 

Windows 7 to Windows 10. However, the system performance depends on the size of the 

raster and vector data sets that are to be analysed and the computational complexity of the 

analysis tasks to be performed. Therefore, the following system specification (or better) is 

recommended for optimal use of the software: 

CPU:    Intel Core i5-3570 Processor (Quad Core, 3.40GHz)  

Memory:   16GB (2X4GB) 1600 MHz DDR3 Non-ECC  

Disk Space:   1TB 3.5inch Serial ATA III (7.200 Rpm) Hard Drive  

Display:   1024 x 768 resolution or higher, 24 bit colour depth  

Video Card:   1GB AMD Radeon HD 7570  

Operating System:  Windows 7 or higher (64 bit)  

 

2.3 Semi-automatic installation 

GW-A Toolbox version 2.0 comes with a wizard-like utility which will guide you through the 

installation process by starting the installers of the toolbox component software in the 

required order and automatically performing the post- and pre-installation tasks.  
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The installation utility is called installer.exe and is located in the same directory as this 

document. It is recommended to keep all the default settings throughout the installation 

process.  

Please read the following points carefully in order to achieve smooth installation of the 

toolbox: 

1. It is recommended to uninstall all components of previous toolbox software installations 

before installing a new version. Please see the next section for details. Note that old QGIS 

plugins will be removed during the installation (e.g. Processing and Processing Workflows). 

Therefore, take a backup of any customized models, scripts or workflows residing within those 

plugins’ directories. 

2. Some computers are configured with quite restrictive security settings which might cause 

problems when files are copied during installation. Therefore, it is strongly recommended to 

run installer.exe as an Administrator. To do this, right click on installer.exe and select “Run as 

administrator” from the drop-down menu. 

3. Some error messages might pop-up during the first step of installation (“Install OSGeo4W”). 

They can be safely ignored and should not impact the functionality of the toolbox. 

4. If some software components are missing or not working properly after the installation 

then please refer to section 3.1 Troubleshooting. 

2.4 Uninstalling previous version of GW-A Toolbox 
If you are updating from a previous version to GW-A Toolbox 2.0, or if you have some of the 

software components already installed, it is recommended to uninstall them in case they 

interfere with the installation or operation of GW-A Toolbox 2.0. 

Uninstalling QGIS, GRASS, Orfeo Toolbox (OTB) and Python 

QGIS, GRASS, OTB and Python are installed using the OSGeo4W installer and do not have an 

uninstallation utility. To uninstall those, simply delete the entire OSGeo4W folder, usually 

located in C:\OSGeo4W or C:\OSGeo4W64, any desktop icons related to the software or 

OSGeo4W and the OSGeo4W folder in the Windows Start Menu. 

If you have previously installed QGIS 3.x then rename or delete folder  

C:\Users\gwauser\AppData\Roaming\QGIS\QGIS3. NB: any script and workflow 

customizations and installed plugins are contained in this folder, so consider making a backup. 

Uninstalling other GW-A Toolbox software components 
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The other software can be uninstalled from the Windows Control Panel. In the Control Panel 

select Add or Remove Programs if you are using Windows XP or Programs and Features if you 

are using newer Windows versions. In the list of installed programs find and uninstall (if they 

are present) the following software: 

QGIS 2.x / 3.x 

SNAP 

R 

Uninstalling unused GW-A Toolbox software: 

The software listed below were used by previous versions of GW-A Toolbox but since version 

2.0 are no longer required. If you do not use this software for any other purpose apart from 

GW-A Toolbox then you can uninstall it to save disk space: 

PostGIS 

PostgreSql 

SWATEditor 

MWSWAT 

MapWindow 

TauDEM 

BEAM 
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2.5 Manual installation 
If for some reason you cannot use the semi-automatic installation utility (see section above), 

follow the instructions below to install the GW-A Toolbox manually. Read the instructions 

provided below carefully and proceed gradually with the installation of the various software 

components. All the software components are located in the following folder on the installer: 

GWA_InstallationPackage_x64_2.0\Installations_x64 

Note: The GW-A Toolbox only installs on 64-bit computers. 

Installing QGIS, GRASS, Orfeo Toolbox (OTB) and Python using OSGeo4W installer 

 

• Run osgeo4w-setup.bat 

• Reboot the computer if prompted  

Installing SNAP Toolbox 

• Run esa-snap_sentinel_windows-x64_8_0 leaving all the default options. 

• Configure snappy (the SNAP Python interface) by running snappy_conf.bat and 

passing to it the paths to the OSGeo4W Python installation and OSGeo4W Python 

libraries. If you left the default options, then the command should be as follows: 

C:\Program Files\snap\bin\snappy-conf.bat C:\OSGeo4W64\bin\python-qgis-ltr.bat 

C:\OSGeo4W64\apps\Python37\lib\site-packages 

• The amount of heap space (RAM memory) available to SNAP Toolbox can be set by 

editing the gpt.vmoptions file. If you left the default options it should be in the 

C:\Program Files\snap\bin directory. Right click on the file, select edit and set the –

Xmx option to the desired number (e.g. for 6000 megabytes of RAM set the option 

to –Xmx6000M). Sometimes, due to Windows security settings, it is not possible to 

save the modified gpt.vmoptions  file. In this case make a copy of gpt.vmoptions on 

the desktop, modify it there and then copy back to the original folder overwriting the 

existing gpt.vmoptions. Also, you need to modify snappy.ini file and set 

java_max_mem field. If you left the default option, then it should be in the 

C:\OSGeo4W64\apps\Python37\lib\site-packages\snappy directory. 

• Copy all the directories from “SNAP additional modules” to the SNAP installation 

directory. If you left the default option, then it should be C:\Program Files\snap. 
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• Start SNAP, in the main menu select Tools > Options, go to S3TBX tab and tick the 

box next to Read Sentinel-3 OLCI products with per-pixel geo-coding instead of using 

tie-points. 

Installing R 

• Run R-3.3.3-win.exe leaving all the default options. 

Installing and setting up QGIS plugins 

• Extract the zip archives models_and_workflows, rlibs and scripts in “QGIS additional 

software” directory into 

“C:\Users\your_users_name\AppData\Roaming\QGIS\QGIS3\profiles\default\proces

sing” directory, remembering to change your_user_name in the path to the actual 

user name. If the directory does not exist, create it. Otherwise overwrite any files 

and directories already present if asked.  

• Extract the zip archive python_packages in “QGIS additional software” directory into 

“C:\OSGeo4W64\apps\Python37\lib\site-packages” directory. Overwrite any files 

and directories already present if asked.  

• Copy the content of plugins folder in “QGIS additional software” directory into 

“C:\Users\your_user_name\AppData\Roaming\QGIS\QGIS3\profiles\default\python\

plugins” directory, remembering to change your_user_name in the path to the actual 

user name. If the directory does not exist, create it. Otherwise overwrite any files 

and directories already present if asked.  

• Start QGIS Desktop 

• Select Plugins > Manage Plugins…from the main menu, find the QuickMapServices 

Plugin, Processing, Processing BEAM and SNAP algorithm Provider, Processing R 

Provider, Processing Workflows, LecoS and ThRasE plugins in the list and tick the 

boxes next to them – when finished click Close. 
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• If you need to modify any Processing options they can be accessed from the main 

menu: Settings > Options > Processing. Under the Providers section you need to 

activate GRASS, OTB,  SAGA, R, SNAP, and GWA TBX collection under Workflows 

providers. You also need to set the path to the OTB,  SNAP and R and installation 

directories.  

• Restart QGIS 

 

3 Basic usage instructions 
Regardless of the installation method QGIS provides the user interface to all of the GW-A 

Toolbox software components. Clicking the GlobWetland Africa icon on the main QGIS task 

bar will open toolbox dialog containing all the processing workflows. Individual software 

components’ functions can be accessed by opening the Processing Toolbox. It is accessible 

from the QGIS main menu under Processing > Toolbox. 
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A workflow can be started by selecting it from the list and double clicking: 

 

Any encountered errors will be available from the Log Messages Panel. In QGIS Go to: 

View > Panels > Log Messages or simply click on the  icon in the lower right corner:  
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3.1 Troubleshooting 

Issue Solution 

Installation 

failure 

Make sure to run the installation as administrator. Also be aware that 

usernames can't have spaces or special characters.  

Missing 

componen

ts 

Make sure that all the instructions from section 2.3 (if semi-automatic 

installation was used) or section 2.5 (if manual installation was used) were 

followed. If it is discovered that some instructions were not followed, 

uninstall the toolbox as described in section 2.4 and perform the installation 

again. 

QGIS 

Processing 

Toolbox 

crashes 

when 

starting 

QGIS 

Some QGIS plugins could clash with QGIS Processing Toolbox and make it (or 

QGIS) crash when starting QGIS. Plugins which are included with the 

GlobWetland-Africa Toolbox have been tested and are known to work well. 

If you have installed other plugins and notice this issue then try updating 

them to the latest version and if that does not help then uninstall them or 

remove from 
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C:\Users\user_name\AppData\Roaming\QGIS\QGIS3\profiles\default\pyth

on\plugins directory. 

Bugs 

encounter

ed in GW-

A Toolbox 

If you encounter software bugs in the toolbox please report them through 

the GlobWetland Africa GitHub web page: 

https://github.com/GlobWetlandAfrica . At the main page select the 

repository which you think is the most relevant to the encountered issue and 

then click the Issues link on the right side to the page. Read through any 

existing issues before creating a new one using the New issue button. 

 

 

 

 

 

 

 

 

 

 

System Overview 

https://github.com/GlobWetlandAfrica
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4 Toolbox Overview 
This section provides a high-level view of the GW-A Toolbox through a conceptual model (cf. 

Figure 1). The conceptual model seeks to illustrate the different elements and functions of 

the system. The more detailed system structure including the software building blocks and 

their interaction as well as the main principles of system and workflow development are 

provided in subsequent chapters.  

The GW-A Toolbox can be seen as a multipurpose system consisting of functionality for  semi-

automated processing and analysis of the EO data through customized processing facilities, 

and decision support tools for mapping and reporting (cf. Figure 1). 

 

 

Figure 1. The GW-A Toolbox is developed as a customisation of the ‘Platform’ which is a complete suite of open 

source software for managing, processing and analysing Earth Obser-vation data and building customised 

workflows to cover multiple needs, from those of wetland specialists and engineers to managers and policy 

makers 

4.1 Software Architecture 

The GW-A Toolbox development is based on a modular software architecture framework, 

which is structured around a central component controlling a number of extension 
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components that expand its core functionality. The central component of the GW-A toolbox 

is an open source geographic information system (GIS) software, QGIS, which provides the 

basic functions and features for working with geospatial data and an easy to use graphical 

user interface (GUI). The other confirmed components of the GW-A toolbox are: GRASS GIS 

and SAGA GIS (large toolboxes of raster and vector analysis algorithms), Sentinel Application 

Platform - SNAP (processing of visible, thermal and radar ESA data products), Orfeo Toolbox 

(high resolution image processing), Python and R-scripts (advanced  analysis). 

  

 

 

Figure 2. Open source software packages providing the required functionality for the GW-A toolbox. 
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4.2 Graphical User Interface 

QGIS was chosen as the central integrating platform, due to its clear and accessible GUI, 

strong development community, ease of implementing additional functionalities through 

Python plugins and its high level of interoperability with major GIS data formats through the 

use of the Geospatial Data Abstraction Library (GDAL/OGR) library. 

 

Figure 3. Schematics of the graphical user interface (GUI) for the GW-A Toolbox. The GUI is based on QGIS, but 

modified to include a GW-A Toolbox button on the menu ribbon. This button loads the Toolbox from where the 

user can select and run the customized end-to-end processing workflows for the entire suite of GW-A products 

and indicators. 

 

All the software components to be used for EO processing (i.e. GRASS, Orfeo Toolbox, SNAP, 

R and Python scripts) are seamlessly integrated into QGIS via the Processing framework. 

4.3 Workflow, Scripts and Models 

A QGIS plugin has been developed that enables the creation of workflows from individual 

Processing algorithms. The Processing workflow plugin comes with a workflow creator tool 

which provides a simple GUI for creating new workflows and modifying the existing ones (see 

Figure 4). Once a workflow is saved it appears in the Processing toolbox among all the other 

tools, and also under an icon on the main QGIS toolbar. The saved workflows do not contain 
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any information on the internal workings of the algorithms used within the workflow steps, 

making them robust in case there are any changes to those algorithms.  

 

The workflows provide a step-by-step guidance through more complex GIS processes, such as 

wetland classification, with the output of earlier steps being used as the input to the later 

ones. Once an algorithm has been integrated into the Processing toolbox it can be used inside 

workflows without any restrictions. The workflows can contain steps with tools from different 

algorithm providers, allowing the workflow creator to exploit the strengths of all the providers 

available within Processing.  

Processing also provides functionality to call the different algorithms inside simple Python 
scripts and thus to create new tools. This is useful, for example, when it comes to processing 
time-series data. Instead of the user having to repeat the same operation multiple times on a 
large number of time-series images, the script can automate the process. Saved scripts appear 
in the Processing toolbox along with all the other algorithms, and they are presented to the 
user with the standardized GUI and can be included in workflows.  

Finally, the Processing models can be used, similarly to scripts, for automatizing algorithm 

execution. However, unlike scripts, the models can be created using a drag-and-drop GUI 

interface thus making them easier to create and modify for non-technical users (cf. Figure 5).  

Figure 4. Illustration of the graphical user interface for creating step-by-step processing wizards. 
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4.4 GW-A Toolbox workflows 

In addition to the ability for users to develop their own image processing workflows the GW-

A Toolbox also comes with a number of processing workflows that have been developed in 

response to the user requirements for products and tools to support mapping of wetland 

extent and condition. The embedded workflows in the current GW-A Toolbox version are as 

follows: 

1. Pre-processing 

• These processing workflows allow users to  perform the necessary pre-
processing steps of Sentinel-1, sentinel-2 and Landsat 8/9 to prepare data for 
subsequent analysis and classification. 

2. Wetland (Habitat) Mapping 

• The Wetland Habitat Mapping workflows provides the needed functionality to 
perform a detailed classification of the state and change in land cover and land 
use in wetland sites and their surrounding areas. 

  

Figure 5. The QGIS drag-and-drop model builder 
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3. Post-processing 

• The post-processing workflow provide the users with the opportunity to perform 
manual post-classification editing. 

4. Validation tools 
• The validation workflows can be used to generate sample locations and used 

them to perform Accuracy Assessment i.e. an independent verification of map 
outputs. 

5. Wetland indicators 

• The wetland indicator workflows allow users to generate wetland status and 
trend indicators from the wetland information products. It also contains a 
workflow for Sustainable Development Goal (SDG) indicator 6.6.1 reporting. 

 

For each of the workflows a small training kit has been prepared that consist of background 

presentations, a step-by-step tutorial and a tutorial data set designed to help the users 

become familiar with the features and capabilities of the GW-A Toolbox. The training kit is 

distributed as separate appendix to this document. 

5 Updates 

This section will include notifications of important updates for future releases of the 

GlobWetland Africa Toolbox 

Version 1.2 

General bug fix and updating of software components to latest versions. This version also 

includes new validation tools including functionality for generating stratified random 

samples:  

• Creation of sampling unit polygons to match raster resolution 

• Option for 3 x 3 pixel sampling unit 

• easy creation of .kml files for Google Earth 

Accuracy assessment now done by one single tool 

• Class value extraction done in same script as error matrix and statistics 

Now supports weighted accuracy assessments and unbiased area Statistics. 

• Implementation of methods from Olofsson et al. 2013 & Card 1982 

• Proportional weighted accuracy estimators 

• Unbiased area estimates (corrections applied using error matrix) 
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• Confidence intervals (95%) supplied with all statistics 

Version 1.3 

General bug fix and updating of software components to latest versions. This version also 

includes a new placeholder for indicator workflows, including: 

• SDG 6.6.1.a reporting 

o This workflow allows users to report on SDG 6.6.1.a “spatial extent of water 

related ecosystems” by returning area statistics on vegetated wetlands and 

open water respectively within a user defined region (e.g. a country mask) 

• Wetland area statistics 

o Calculates the area present in each of the categories of a user-selected map 

• Wetland change (post-classification comparison) 

o A detailed tabulation of changes between two maps 

• Wetland fragmentation 

o Supports generation of both landscape and patch level fragmentation indices 

• Wetland time-series analysis 

o Makes each pixel value a function of the values assigned to the corresponding 

pixels in the input image time-series (e.g. min, max, mean, median, quartile, 

percentile) 

Version 1.4 (beta release) 

This release focused on improving the workflow design, both from functionality and 

visualization perspectives: 

• Standardized the look of all workflows and improved the user experience. This was 

facilitated by new functionality in the Workfows plugin allowing for the usage or 

Markdown syntax and cascading style sheets (CSS) when styling workflow instructions. 

• Addition of workflow for national-scale Sustainable Development Goal (SDG) indicator 

6.6.1 reporting. 

• Various fine-tuning of workflow steps and associated R and Python scripts and 

Processing models. 

 

Version 1.5  

This is the final release of the toolbox as part of the GlobWetland-Africa project. It sets the 

scene for long-term exploitation of the toolbox and for possible future developments. 
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• Replacement of SWAT hydrological modelling framework by TauDEM-Budyko 

modelling framework. This removes a lot of software dependencies (e.g. 

MapWindow) thus simplifying the installation and future maintenance. It also 

removes the last major obstacle to cross-platform (Windows and Linux) toolbox usage. 

The hydrological outputs are still of high accuracy1. 

• Update of toolbox software components to: 

o QGIS 2.18.28 – this is the last QGIS release of the 2.x series and has been in 

long-term support for over a year 

o SNAP 6.0.6 

o GRAS 7.4.4 

o OrfeoToolbox 5.0.0 

o Python 2.7.14 

o TauDEM 5.3 

• Removal of PostGIS which was not utilized within the toolbox. 

• Various fine-tuning of workflow steps and associated R and Python scripts and 

Processing models.  

Version 2.0 

This is the latest major update to the GWA toolbox to ensure align it with the latest 

developments of the underlying software components, namely QGIS 3.x, GRASS GIS, Orfeo 

Toolbox and SNAP.  This release is also simplifying the backend to ease the installation, 

operation and maintenance of the toolbox.  

• Update of toolbox software components to: 

o QGIS 3.16 – this is a long-term support release 

o SNAP 8.0.8 

o GRAS 7.8 

o OrfeoToolbox 7.3.0 

o Python 3.7 

o R 3.3.3 

o TauDEM (removed) 

The simplification also means that certain previously supported product groups is no longer 

supported including wetland inventory, inundation regime, water quality, hydrological 

modelling and mangroves mapping. User still interested in wetland, mangroves and 

 
1 Kittel, C. M. M., Nielsen, K., Tøttrup, C., and Bauer-Gottwein, P.: Informing a hydrological model of the Ogooué 
with multi-mission remote sensing data, Hydrol. Earth Syst. Sci., 22, 1453-1472, https://doi.org/10.5194/hess-
22-1453-2018, 2018. 
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inundation mapping can still do this for limited areas using the Wetland (Habitat) Mapping 

workflows, while users interested in Hydrological Modelling can still access the Python 

implementation of the Budyko hydrological modelling scheme and its QGIS integration here: 

https://github.com/DHI-GRAS/budyko-qgis 

 

6 Software references 

The software components included as part of the GW-A Toolbox are all established open 

source/public domain packages with a long history, a very strong user community and 

extensive online documentation. The following table briefly describes the included software 

components and provides links to their respective webpages for further reading. 

QGIS (formerly known as Quantum GIS) is a powerful and user friendly Open Source Geographic 
Information System licensed under the GNU General Public License (GPL). 

For more information see www.qgis.org  

Geographic Resources Analysis Support System, commonly referred to as GRASS-GIS, is an advanced 
open source GIS and image processing software, which is licensed under GNU GPL. 

For more information see http://grass.osgeo.org/  

Orfeo Tool Box (OTB) is an Open source library of advanced image processing algorithms for high 
resolution images. OTB is distributed under a free software license CeCILL (similar to GPL) 

For more information see http://www.orfeo-toolbox.org  

Sentinel Application Platform is an open source (GNU GPL) toolbox for reading, post-processing, 
analysing and visualising the large archive of data from ESA SAR missions including ERS-1 & 2, 
ENVISAT and Sentinel 1, 2 and 3. 

For more information see http://step.esa.int/main/toolboxes/snap/  

R is a statistical software package which can be applied for statistical analysis (e.g. linear and 
nonlinear modeling, classical statistical tests, time-series analysis, classification, clustering.) and 

graphical techniques. R is available as Free Software under the GNU GPL. 

For more information see http://www.r-project.org/  

Python is a scripting language, very popular with scientific and geographic 
communities. It includes numerous packages for GIS analysis, advanced modelling and 

data processing. Python is available as Free Software under Python Software Foundation license.  

For more information see https://www.python.org/ 

 

 

https://github.com/DHI-GRAS/budyko-qgis
http://www.qgis.org/
http://grass.osgeo.org/
http://www.orfeo-toolbox.org/
http://step.esa.int/main/toolboxes/snap/
http://www.r-project.org/
https://www.python.org/
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License 

The GlobWetland Africa Toolbox is a free software; you can redistribute it and/or modify it under the terms of 
the GNU General Public License as published by the Free Software Foundation; either version 2 of the License, 
or (at your option) any later version. 

The full GNU General Public License is available in LICENSE.txt or http://www.gnu.org/licenses/gpl.html 

Disclaimer of Warranty (GPLv3) 

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM 
“AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK 
AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

Limitation of Liability (GPLv3) 

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, 
OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO 
YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA 
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE 
PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

Contact 

Any questions regarding the GW-A Toolbox can be directed to: 

Project Lead Software Developer ESA Technical Officer 

Dr. Christian Tøttrup 

DHI GRAS A/S 

Agern Allé 5  

DK-2970 Hørsholm 

Denmark 

phone: +45 4516 9481 

cto@dhi-gras.com 

Radoslaw Marcin Guzinski 

DHI GRAS A/S 

Agern Allé 5  

DK-2970 Hørsholm 

Denmark 

phone: +45 4516 9479 

rmgu@dhigroup.com 

Marc Paganini 

European Space Agency, ESA-ESRIN 

Exploitation & Services Division, Project Section 

00044 Frascati 

Italy 

phone: +39-06-941-80 653 

marc.paganini@esa.int  

 

http://www.gnu.org/licenses/gpl.html
mailto:cto@dhi-gras.com
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